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1. Préface 

Un système d'information géographique (SIG) peut être un outil utile pour préparer les 

données pour modèles et outils. De plus, dans cette ère de partage de données, des 

données à libre accès (Open Source Data) peuvent facilement être récupérées à partir 

d'Internet et intégrées dans des logiciels de bureau SIG Open Source, tels que QGIS. 

 

Ces exercices vous guideront à travers les différentes étapes qui sont nécessaires pour le 

prétraitement de données à être ensuite utilisé dans des modèles et outils hydrologiques. 

Dans le premier exercice, vous apprendrez comment enregistrer une carte topographique 

numérisée et l'utiliser comme toile de fond pour la numérisation des données vectorielles. 

Dans le deuxième exercice, vous apprendrez comment importer des données à partir de 

feuilles de calcul dans un SIG et utiliser le logiciel pour joindre des tables, manipuler des 

tables d'attributs et interpoler les données à une couche Raster continue. Dans le troisième 

exercice, vous allez télécharger les données Open Source de OpenStreetMap et les utiliser 

pour un exercice d’analyse et de convertion. La géodatabase sera également introduite 

dans cet exercice. Dans le quatrième exercice, vous allez utiliser de l’algèbre cartographique 

pour l’aide à l'aménagement du territoire. Enfin, vous apprendrez à délimiter les bassins 

versants et les cours d'eau à partie de modèles numériques d'élévation, et à les présenter 

sous forme de cartes ou dans une page Web interactive. 

 

Les exercices ont été développés pour différents programmes de Master à l'UNESCO-IHE 

et pour des formations en Ouganda, financé par les fonds internationaux Vitens Evides 

(VEI). Nous tenons à remercier Jan Hoogendoorn et Jonne Kleijer, experts SIG de VEI, pour 

leur contribution à ces exercices. Nous mettons à jour ces exercises continuellement et les 

distribuions comme OpenCourseWare afin que toute communauté puisse les utiliser. 

2. Objectifs d’apprentissage 

Après avoir suivi ce tutoriel étape par étape, vous serez en mesure de: 

• Utilisez QGIS dans ses principales fonctionnalités, également en liaison avec des plugins 

• Numérisez des caractéristiques à partir d'une carte numérisée ou image satellite 

• Importer des données tabulaires dans un SIG 

• Effectuer une analyse de Vector simple 

• Interpoler des données de points 

• Convertir des données vectorielles et matricielles 

• Reprojeter des données vectorielles et matricielles 

• Utiliser l’algèbre cartographique 

• Utiliser les données en ligne 

• Délimitation des bassins versants 
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2.1 Logiciels  

Au cours des prochains exercices, nous allons utiliser les logiciels suivants: 

• QGIS version 2.14 (Essen) ou plus, 

• Google Earth, 

• Firefox Mozilla, 

• MS Excel ou OpenOffice Calc, 

Vous avez besoin d'une connexion Internet pour télécharger des plugins et utiliser des 

données Open Source. 

2.2 Préparation 

1) Télécharger QGIS à l’adresse http://www.qgis.org/en/site/forusers/download.html 

2) Installez QGIS 

3) Installez les données d'exercice de http://ocw.unesco-ihe.org 

2.3 Convention 

Tout au long de ce guide, nous avons utilisé trois polices différentes en fonction du type 

d'opération que nous voulions pointer: 

 

 Arial, est utilisée pour le texte principal 

 Arial, italique, est utilisé pour identifier les commandes logicielles 

 Courier New est utilisé pour la saisie de texte, qui est le texte 

que vous avez à écrire dans le logiciel, ou pour les noms de 

fichiers 

3. Se familiariser avec QGIS 

3.1 Démarrer QGIS 2.14.0 

Vous pouvez démarrer QGIS Desktop en cherchant dans le menu Démarrer ou en utilisant 

la fonction de recherche. Assurez-vous que vous ouvrez le QGIS Desktop avec Grass afin 

d'avoir toutes les fonctionnalités dont nous avons besoin. 

http://www.qgis.org/en/site/forusers/download.html
http://ocw.unesco-ihe.org/
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3.2 L’écran 

Comme beaucoup de logiciels SIG commerciaux, QGIS possède un agencement SIG 

"traditionnel". 

Il est composé du Standard System Menu (Menu de Système Standard) ou « Menu 

principal » qui est toujours en haut sur la fenêtre du logiciel, de barres d'outils standard 

incluant les outils tels que le zoom, ou d'autres qui peuvent être activées en cliquant dans le 

menu principal sur View (Affichage) puis Toolbars (Barres d'outils). 

 

Sur le côté gauche, il y a la table des matières (liste des couches), où toutes les couches 

ouvertes sont affichées. A gauche de cet espace il y a une barre d'outils verticale; la barre 

d’outils de gestion des couches. 

 

Dans le centre de la fenêtre, il y a la Map Area (région pour la carte), où toutes les cartes 

sont affichées. 

Plus d'informations peuvent être trouvées sur le Graphical User Interphase (GUI) de QGIS: 

http://docs.qgis.org/2.14/en/docs/user_manual/introduction/qgis_gui.html 

 

http://docs.qgis.org/2.14/en/docs/user_manual/introduction/qgis_gui.html
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4. Exercise 1: Numérisation à partir d'une carte scannée 

4.1 Introduction 

Pour utiliser des cartes imprimées dans un SIG, elles doivent être numérisés et 

géoréférencées. Le géoréférencement est également nécessaire pour les images de 

télédétection premières, telles que des photographies aériennes et des images satellites. 

Pour le meilleur résultat, choisissez une feuille de carte qui est propre et n’a pas trop de plis. 

Utiliser un scanner qui est assez grand pour balayer toute la carte. La résolution du scanner 

devrait être suffisamment grande (par exemple 1200 ppp) pour avoir les détails et de la 

qualité dans le Raster résultant. 

Pour le géoréférencement, nous avons besoin de relier des emplacements coordonnées sur 

l'image numérisée. Il y a deux façons: 

1. Collectionner des points de contrôle au sol (Ground Control Points, GCP) à des endroits 

qui sont clairement visibles dans l'image, comme les ponts et les carrefours. 

2. Si la carte papier contient une grille de coordonnées, vous pouvez utiliser la grille 

imprimée comme une référence. Assurez-vous que vous connaissez la projection de cette 

grille, qui est généralement indiqué sur la carte. 

 

Dans cet exercice, nous allons utiliser une carte numérisée du mont Marcy (USGS, 1979) 

(Mount_Marcy_New_York_USGS_topo_map_1979.JPG), que nous géoréférenceront 

avec la grille de coordonnées imprimées sur la carte. Vous pouvez trouver les données 

(Exercice de données 1) sur le site de OpenCourseWare (http://ocw.unesco-

ihe.org/course/view.php?id=11). 

4.2 Choisir une projection 

Jetez un œil à la carte numérisée et essayer de trouver la projection qui a été utilisé. Quelle 

projection a été utilisée? Recherchez le code EPSG dans http://www.spatialreference.org et 

notez-le. 

4.3 Activer le plugin de géoréférencement GDAL 

Le Plugin Georeferencer GDAL est un plugin essential, ce qui fait qu’il est déjà installé. Pour 

l’utiliser, il faut l’activer ainsi:  

1. Dans le menu principal, allez à Plugins > Manage and install plugins… 
2. Cherchez Georeferencer GDAL et cochez la case 
3. Cliquez Fermer pour fermer la boîte de dialogue 

http://ocw.unesco-ihe.org/course/view.php?id=11
http://ocw.unesco-ihe.org/course/view.php?id=11
http://www.spatialreference.org/
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4.4 Importation d'une carte numérisée dans le plugin Géoréférence 

GDAL 

1. Dans le menu principal, choisissez Raster > Georeference > georeferenced... 

 

2. Cliquez sur le bouton Ouvrir Raster . 
3. Recherchez le fichier Mount_Marcy_New_York_USGS_topo_map_1979.JPG 
4. Une fenêtre apparaît où vous devez spécifier le système de référence (CRS) de 
coordonnées de cette carte d'entrée. Il ne dispose pas encore d'un CRS, donc 
cliquez sur Annuler. 

4.5 Réglage des paramètres de transformation 

Nous devons d'abord définir les paramètres de transformation (voir également la capture 

d’écran sur la page suivante). 

1. Dans le menu, sélectionnez Settings (paramètres) > Transformation settings... 

2. Ici vous pouvez choisir: 

a. Le type de transformation. Une transformation linéaire simple peut être utilisée si la carte 

est peu déformée. Les autres peuvent être utilisées lorsque plus de déformation existe. 

Nous allons commencer par une transformation linéaire. 
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b. La méthode de rééchantillonnage: si vous avez besoin des valeurs de pixels dans 

d'autres calculs, il est préférable de choisir l'option du plus proche voisin. Cette méthode de 

rééchantillonnage permettra de préserver autant que possible les valeurs d'origine de pixels 

en choisissant le plus proche. Visuellement, cependant, cette méthode se traduit par une 

carte "polyédrique". Si le but est uniquement pour une utilisation visuelle, par exemple en 

toile de fond pour la numérisation de couches vectorielles, alors il est préférable de choisir 

une autre méthode de rééchantillonnage. Ici, nous allons utiliser la méthode cubique, qui 

utilise la moyenne des 4 pixels les plus proches. 

c. Le système de coordinnées spatiales (CRS) cible: choisissez ici le code que vous avez 

noté précédemment; EPSG: 26718 

Accédez au dossier où vous souhaitez enregistrer la carte géoréférencée. L'outil ajoute 

automatiquement _modified au nom de fichier. Donc, dans notre cas, le fichier 

géoréférencée sera nommé 

Mount_Marcy_New_York_USGS_topo_map_1979_modified.tif 

Gardez les autres paramètres de défaut et cochez la case Load in QGIS when done 

(Charger dans QGIS lorsque terminé). La boîte de dialogue devrait ressembler à celle ci-

dessous. 

 

 



 

Utilisation de logiciels Open Source pour le prétraitement de données SIG pour modèles 

hydrologiques 

_________________________________________________________________________ 

 

 

 

 

 

 

10 

4.6 Ajout de points de contrôle au sol (Ground Control Points, GCPs)  

Afin de lier les coordonnées du fichier aux coordonnées du monde réel, nous avons besoin 

d'indiquer les points de contrôle au sol (GCPs) avec des coordonnées connues. Nous 

pouvons obtenir ces coordonnées de différentes manières: 

• Le plus simple est d'utiliser la grille de coordonnées sur la carte numérisée si elle est 

disponible et si elle est dans une projection connue. Nous cliquons sur un nœud dans la 

grille et entrons les coordonnées X et Y dans la boîte de dialogue. 

• L'utilisation d'une carte de référence sur la carte toile QGIS qui a déjà été géoréférencée. 

De cette façon, nous pouvons obtenir les bonnes coordonnées en cliquant sur la carte de 

référence. 

• Utilisation de GCPs qui ont été mesurés sur le terrain en utilisant un GPS. 

Pour cet exercise, nous allons utiliser la grille de coordonnées qui est imprimé sur la carte. 

1. Zoomez sur la coordonnée 581000 Est et 4885000 Nord. 

2. Cliquez sur le bouton  pour ajouter un point GCP. 

3. Saisissez les coordonnées de la carte dans la fenêtre pop-up: 

 
 

Si vous avez une carte de référence dans la carte toile de QGIS, vous pouvez 
utiliser le bouton From map canvas pour capturer les coordinées. Ici, nous allons 
seulement taper les coordonnées de la grille. 
4. Appuyez sur OK. Maintenant, votre écran devrait ressembler à ceci: 
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Le point rouge correspond à l'emplacement que vous avez référencé. Dans le tableau en 

dessous la carte, vous pouvez voir les coordonnées Source X et Y. Ce sont les coordonnées 

de fichiers non référencés. Leurs valeurs dépendent du pixel que vous avez selectionné en 

placant le GCP, il peut donc différer de la capture d'écran ci-dessus. Dest. X et Dest. Y 

montrent les coordonnées du monde réel que vous avez lié à cet emplacement. Les autres 

champs de la table ont à faire avec une précision estimée et seront remplis après avoir 

ajouté plus de points. 

5. Choisissons un second GCP dans le coin supérieur droit de la carte et procéder de la 

même manière que le premier GCP. Votre écran doit ressembler à ceci: 
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Vous pouvez voir que certaines statistiques d'erreurs ont été calculées. Avec seulement 

deux points, cela n’a pas beaucoup de sens. Le montant minimum de GCP pour une 

transformation linéaire doit être 4. 

6. Ajouter d’une manière similaire un GCP dans le coin inférieur gauche et le coin inférieur 

droit de la carte. Si vous avez fait une erreur, vous pouvez supprimer le GCP en utilisant le 

bouton . Votre écran doit ressembler à ceci: 
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Au bas de l'écran, vous pouvez voir l'erreur moyenne estimée dans les unités 

cartographiques (40.4217 mètres dans le cas présenté ici). L'erreur est également indiquée 

au GCP en utilisant une ligne rouge. Une grande erreur indique que la déformation est trop 

importante pour utiliser une transformation linéaire. Si nous changeons à un autre type de 

transformation dans les paramètres de transformation, les valeurs d'erreur seront 

recalculées. 

 

7. Dans le menu Paramètres, aller de nouveau à Settings  Transformation Settings… et 

maintenant, nous allons sélectionner un 1er ordre polynôme (Polyniomial 1) au lieu de la 

transformation linéaire. Gardez le reste comme il était. Cliquez sur OK pour revenir à la table 

de GCP. Maintenant, vous pouvez voir que l'erreur moyenne a été réduite à 0,505627 m, ce 

qui est acceptable. 

8. Maintenant, nous pouvons commencer à géoréférencer en utilisant le bouton . Après 

un certain temps de calcul, la carte géoréférencée apparaît dans la fenêtre de carte QGIS. 

Vous pouvez fermer le plugin géoréférencement. Il vous demandera si vous voulez 

enregistrer vos GCP. Vous pouvez cliquer sur Annuler si vous ne voulez pas les utiliser. Si 

vous les enregistrez, vous pouvez les charger à nouveau dans le plugin géoréférencement. 

 

9. Afin de vérifier vos résultats, vous pouvez utiliser le plug-in de capture de coordonnées. Si 

il n'a pas encore été activé, vous pouvez le faire en choisissant dans le menu: Plugins > 

Manage and install Plugins… (Gérer et installer Plugins). Recherchez ensuite le plugin 

Coordinate Capture Plugin et cochez la case pour l’activer, puis cliquez sur Fermer: 

 
 

10. Un panneau est apparu dans la liste des couches. Cliquez sur Démarrer la capture. 

Cliquez sur un nœud de grille de la carte et les coordonnées sont affichées dans le 

panneau: 
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Lire les coordonnées du coin de la carte et vérifier si elles sont correctes. 
 
11. Une autre façon de vérifier le résultat est d'utiliser les cartes du plug-in 
QuickMapServices comme toile de fond. Si pas encore installé, installez le plugin 
QuickMapServices: dans le menu principal, sélectionnez Plugins > Gérer et installer 
Plugins ... et recherchez le plugin QuickMapServices et installer. 
Après l'installation, choisissez dans le menu principal Web > QuickMapServices 
plugin et essayer quelques-unes des options. 

4.7 Digitalisation de couches vectorielles à partir d'une toile de fond 

géoréférencées  

Notre carte scannée géoréférencées peut maintenant être utilisé comme toile de fond pour 
numériser des calques vectoriels. Les vecteurs peuvent être des points, des (poly)lignes ou 
des polygones. Dans cet exercice, nous allons numériser: 
• Sommets de montagne comme points 
• Rivers comme (poly)lignes 
• Lacs comme polygones 
Les étapes suivantes vous guident à travers le processus. 
1. Tout d'abord, nous devons créer un Shapefile vide. Dans le menu principal, sélectionnez 
Couche > Créer couche > Nouveau Shapefile... 

 
 
2. Dans la boîte de dialogue New Vector Layer (Nouvelle couche Vector), nous précisons 
que nous créons une couche de Points. Pour le CRS, nous choisissons celle de la feuille de 
fond topographique (EPSG: 26718). Vous pouvez utiliser la flèche pour choisir la bonne 
projection dans la liste déroulante. Ensuite, nous devons créer un nouvel attribut. Dans la 
liste des attributs vous pouvez voir que, par défaut, il y a déjà un attribut appelé id. Nous 
allons en créer un autre à nommer Élevation. Choisissez nombre entier et largeur 4. Cela 
signifie que nous pouvons stocker des valeurs entières jusqu'à 9999, ce qui est suffisant 
pour tous les sommets sur Terre. 

 

3. Cliquez sur le bouton Ajouter à la liste des attributs. L'attribut est maintenant 
ajouté. La boîte de dialogue devrait ressembler à ceci: 
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4. Cliquez sur OK. 
5. Naviguez jusqu'au dossier où vous souhaitez stocker vos données, nommez le 

peaks.shp et appuyez sur OK. 

6. Le Shapefile vide a maintenant été ajouté à votre liste de couches. 
 

 
7. Afin de commencer à numériser, vous devez basculer en mode édition. Cliquez sur la 

couche peaks.shp de sorte qu'elle soit sélectionnée. 

8. Cliquez sur  pour basculer en mode d'édition. Maintenant, les autres boutons d'édition 

deviennent actifs et un crayon devant le nom de la couche montre que nous éditons la 

couche. 

 

9. Dans la carte topographique, allez au sommet d’une montagne. Les sommets sont 

indiqués par x et une valeur d'élévation. Si vous en avez trouvé un, zoomez et cliquez sur le 

bouton  pour ajouter des fonctionnalités. 
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10. Déplacez la souris vers le sommet. Le curseur se transforme en un réticule. 

Cliquez sur le sommet de la montagne. 

 

11. Un dialogue avec un formulaire apparaît. Ici, vous pouvez remplir les valeurs 
d'attributs: id = 1 et élévation = 738, suivant l’élévation du sommet que vous avez 
sélectionné. 

 
12. Répétez cette étape pour quelques autres pics. Si vous faites une erreur, vous pouvez 

sélectionner et supprimer le point. Ce bouton peut être utilisé pour déplacer un élément 

ponctuel. Enregistrez les modifications. 

13. Lorsque vous avez terminé, cliquez à nouveau sur le bouton pour activer l'édition. Si 

vous ne sauvegardez pas encore les modifications, il vous demandera de sauver ou de 

rejeter. Avec Supprimer vous pouvez toujours annuler vos modifications. 

14. Vous pouvez vérifier la table des attributs de votre nouvelle couche vecteur point par un 

clic droit sur le nom de la couche (peaks.shp) et en sélectionnant Open Attribute Table 

(Ouvrir la table attributaire). 

 
Maintenant, vous pouvez voir les attributs que vous avez ajoutés et leurs valeurs d'identité 

et d'élévation. 
15. Notre prochaine tâche consiste à numériser les caractéristiques d’une ligne. La 

procédure est similaire à la création d'une couche de points. Dans la boîte de dialogue 
Nouvelle couche Vector, choisissez désormais Ligne. Comme nouvel attribut, nous ajoutons 

le Nom de la rivière: type texte, largeur 80. Vérifiez que la boîte de dialogue ressemble à 
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celle ci-dessous et cliquez sur OK. Appelez la nouvelle couche streams.shp.

 
16. Dans la liste des couches sélectionnez streams.shp et activer l'édition. 

17. Cliquez sur  pour ajouter une nouvelle ligne. Zoomez sur la carte pour trouver une 
rivière à numériser. 
18. Cliquez sur le point de la ligne (noeud) de départ et cliquez quand nécessaire pour faire 
une ligne. Vous pouvez utiliser les boutons de zoom et de panoramique pour trace. Vous 
pouvez également modifier la symbologie de visualisation pour voir la ligne que vous 
numérisez plus clairement. Après avoir placé le dernier nœud de la ligne, faîtes un clique 
droit. 
19. Dans la boîte de dialogue, remplissez id=1 et le nom de la rivière. 

 
20. Répétez ces étapes pour quelques ruisseaux et enregistrer vos modifications. Vérifiez la 

table d'attribut. Si vous voulez ajouter des affluents qui se connectent à des flux, jouer avec 

les paramètres d'accrochage (dans le menu principal, allez dans Settings (Paramètres) > 

Snapping Options (Options d’accrochage). 

21. Enfin, nous allons créer une couche vecteur de polygones pour certains lacs. Essayez de 

trouver par vous-même comment faire cela. C’est très similaire à la procédure pour les lignes. 
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La seule différence est que le premier noeud doit être le même que le dernier noeud pour 

fermer le polygone. 

4.8 Enregistrement d’image à image 

Essayez d'utiliser le plugin géoréférencement pour enregistrer la carte numérisée (fichier 

JPG) à une image satellite du Plugin OpenLayers. De cette façon, vous pouvez effectuer un 

enregistrement d’image à image. Est-ce que cela donne de meilleurs résultats? 

 

  

Tout cet exercice peut être consulté dans un 

Screencast à l’adresse: 

https://youtu.be/4IWyVeGhzog 

https://youtu.be/4IWyVeGhzog
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5. Exercise 2: Importation de données tabulaires dans un SIG 

et interpolation 

5.1 Introduction 

Après cet exercice, vous êtes en mesure d'importer des données tabulaires dans un SIG. 

Dans cet exemple, nous allons importer une table avec la température moyenne quotidienne 

le 1er Septembre 2013 à plusieurs stations météorologiques aux Pays-Bas. Les données 

ont été téléchargés à partir du Centre de données KNMI (KNMI, l'Institut royal néerlandais 

de météorologie, http://data.knmi.nl), mais reformaté pour le but de cet exercice. 

Dans cet exercice, nous allons utiliser les données suivantes: 

• KNMI_20130901_tday.xls: table avec des températures moyennes quotidiennes pour 

les différentes stations 

• KNMI_stations.xls: table avec le numéro de la station et les coordonnées de 

l'emplacement des stations 

Ces données peuvent être téléchargées à partir du site web de OpenCourseWare 

(http://ocw.unesco-ihe.org/course/view.php?id=11). 

 

Cet exercice vous guidera à travers les étapes suivantes: 

• Convertir des tableaux Excel en fichiers séparés par des virgules 

• Importer des données tabulaires dans SIG 

• Joindre une table de données à une couche Vecteur avec emplacements 

• Reprojeter des ensemble de données en utilisant la projection locale 

• Recalculer les valeurs dans le tableau d’attribut 

• Interpoler vecteur à raster 

5.2 Convertir des tableaux Excel au format SIG 

1. Ouvrez les fichiers KNMI_20130901_tday.xls et KNMI_stations.xls dans un 

programme de feuille de calcul (par exemple MS Excel) et vérifier le contenu. Quel fichier 

contient les coordonnées? Y at-il un moyen de lier les deux fichiers? Comment pourrions-

nous faire? 

2. Démarrez QGIS bureau 

3. Dans le menu aller à Plugins > Gérer et installer des plugins et vérifier si XyTools est 

installé. Sinon, installez-le. Les plugins sont développés par la communauté QGIS pour 

ajouter des fonctionnalités supplémentaires à QGIS. Avec les XyTools plugin, vous pouvez 

importer de / exporter vers des fichiers Excel par exemple. Notez que XyTools ne peut 

travailler avec des fichiers .xlsx. Si vous avez des fichiers au format .xlsx, vous devez 

l'enregistrer au format .xls d'Excel. 

4. Maintenant, dans le menu, choisir les fichiers Vector  XyTools  Open Excel files as 

http://data.knmi.nl/
http://ocw.unesco-ihe.org/course/view.php?id=11
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attribute table or Point layer (Ouvrir des fichiers Excel comme table d'attributs ou couche 

point). 

 
5. Dans la boîte de dialogue, cherchez l’emplacement du fichier des stations 

météorologiques (KNMI_stations.xls) 

6. Recherchez le fichier et lui donner les paramètres appropriés puis cliquez sur OK. 

7. Ensuite, vous êtes invité à donner le système de référence (CRS) de coordonnées. Ici 

choisir WGS 84 (EPSG: 4326), qui est la latitude / longitude avec référence WGS 84. 

Cliquez sur OK pour continuer. 

 

 
 

8. Ensuite, une boîte de dialogue s’ouvre où vous devez choisir les colonnes avec les 

coordonnées x et y. Quelles colonnes sont-elles? Sélectionnez et cliquez sur OK. 
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9. Maintenant, une carte avec les stations météorologiques est affiché. Si vous ne voyez pas 

la carte, vous avez probablement besoin de zoomer sur l'étendue de la carte: un clic droit 

sur le nom de la couche et choisir Zoom sur la couche. 

10. Renommez le calque KNMI_stations_table (Clic droit sur le calque et sélectionnez 

Renommer). 

11. Maintenant, ajoutez la table avec les données de température de la même manière. 

Lorsque le système de coordonnées de référence est demandé, cliquez sur Annuler. 

Lorsque la fenêtre qui demande les colonnes avec les coordonnées x et y s’ouvre, cliquez 

sur Annuler également. En effet, ce tableau ne contient pas de données géoréférencées. 

Nous devons relier les deux tables pour le rendre géoréférencé. 

12. Renommer également cette couche. Nous l'appelons KNMI_temperatures_table. 

 
13. L'étape suivante consiste à convertir KNMI_stations_table à un format vectoriel 

SIG, à savoir shapefile. Cliquez à droite sur KNMI_stations_table et choisissez 

Enregistrer sous... 
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14. Dans le dialogue Parcourir le dossier pour enregistrer le fichier en tant que 

KNMI_stations.shp. Afin de changer la projection à la projection locale néerlandaise, 

choisir "Selected CRS" et accédez à Amersfoort / RD New en cliquant sur le bouton . 

Astuce: utilisez le champ Filtre pour rechercher le code EPSG 28992: 

 
Ici, vous voyez l'avantage d'utiliser les codes EPSG: il uniformise la projection. Il est donc 

utile de déterminer le code EPSG de la projection avec laquelle vous souhaitez travailler au 

sein de votre projet. À noter également que toutes les cartes de votre projet doivent être 

dans la même projection si vous voulez les combiner dans une analyse SIG ou en 

modélisation. 

Cliquez sur OK. Maintenant, la boîte de dialogue ressemble à l’image ci-dessous. Cochez 

également la case Add saved file to map (Ajouter le fichier enregistré sur la carte): 
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Cliquez sur OK pour continuer. 

15. Retirez knmi_stations_table de l'affichage en faisant un clic droit et en 

sélectionnant Supprimer. Veillez à retirer la bonne couche. Cette action supprime la couche 

de l’écran seulement, le fichier sera toujours sur votre disque dur. Si vous passez votre 

souris sur le nom de la couche, le nom du fichier s’affichera.  

16. Bien que l'ensemble de données knmi_stations.shp est dans la projection EPSG 

28992 (Amersfoort / RD New), l'affichage de QGIS utilise encore la projection EPSG 4326 

(latitude / longitude WGS 84) et a reprojeté knmi_stations.shp à la volée pour la 

visualisation. Afin de visualiser toutes les couches en EPSG 28992 nous devons modifier les 

propriétés du projet QGIS. Dans le menu choisissez Projet > Propriétés du projet... 

17. Sélectionnez l'onglet Système de coordonnées de référence (CRS) 

18. Cochez la case "Activer" à la volée "de transformation CRS" (par défaut, il est déjà 

cochée, à vérifier) 

19. Choisissez parmi les systèmes de coordonnées de référence EPSG récemment utilisés: 

28992, puis cliquez sur OK. 
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Notez que la projection du projet est indiquée en bas à droite de l'écran. Vous pouvez 

toujours vérifier à cet endroit si le code EPSG est correct. Vous pouvez modifier la projection 

sur la volée aussi en cliquant sur ce code EPSG. 

5.3 Joindre des tables d'attributs 

20. Nous avons encore les emplacements des stations et les données de température dans 

des tables séparées. Nous devons les combiner dans un seul fichier de forme. En termes 

SIG on appelle cela l’opération « join » (joindre). Nous ne pouvons joindre des tables que si 

elles ont une colonne en commun. Vérifiez la table des attributs de KNMI_stations (clic 

droit sur KNMI_stations et choisissez Ouvrir la table d’attributs) et de la même manière 

vérifier KNMI_temperatures_table. Quelle colonne les deux tables d'attributs ont-elles 

en commun? 

Après avoir déterminé quelle colonne les deux tables ont en commun, nous pouvons joindre 

les données de KNMI_temperatures_table aux attributs de notre shapefile 

KNMI_stations.shp. 

21. Tout d'abord fermer les tables d'attributs. 

22. Ensuite, faîtes un clic droit sur KNMI_stations et choisissez Propriétés. 

23. Dans le dialogue choisissez le bouton  (joindre). 

24. Cliquez sur le signe + et choisissez vérifier si le dialogue ressemble à celui-ci: 
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Notez que le champ commun est STN (le numéro de la station), puis cliquez sur OK. 
25. Maintenant, la boite de dialogue ressemble à ceci: 

 
Cliquez sur OK pour effectuer l'opération Joindre. 

26. Vérifiez à nouveau la table des attributs de KNMI_stations. Que s’est-il 

passé? 

 
27. Nous avons d'abord besoin d'enlever les valeurs manquantes. Cliquez sur les numéros 

de ligne avec NULL ou pas de valeurs pour la température, tout en maintenant la touche Ctrl 

enfoncée. Maintenant, la table d'attribut ressemble à ceci: 



 

Utilisation de logiciels Open Source pour le prétraitement de données SIG pour modèles 

hydrologiques 

_________________________________________________________________________ 

 

 

 

 

 

 

26 

 

28. Dans la table d’attributs, cliquez sur  pour activer le mode d'édition. 

29. Cliquez sur l'icône  (dans la barre d'outils au-dessus du tableau des attributs) pour 

supprimer les caractéristiques avec des données manquantes. 

30. Le seul problème est maintenant que les températures dans le tableau sont à 0,1 ° C. 

Nous devons convertir les valeurs en ° C. 

31. Cliquez  pour ajouter une nouvelle colonne à la table. Et remplir le dialogue selon 

cette capture d'écran: 

 
La largeur est la quantité de nombres, la précision est la quantité de décimales. 

Cliquez sur OK pour continuer. 
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32. Maintenant, la table d'attribut montre une colonne supplémentaire avec des valeurs 

NULL. Afin de calculer ces valeurs, cliquez  en haut du tableau pour ouvrir le Calculateur 

de champs. 

Remplissez le dialogue comme la capture d'écran ci-dessous. Pour éviter les fautes de 

frappe, la meilleure pratique consiste à double-cliquer sur le nom du champ dans le milieu 

de l'écran de la boîte de dialogue et cliquer sur le bouton *. Ensuite, tapez 0,1. Cliquez sur 

OK pour continuer. 

 
33. Assurez-vous que la fenêtre de la table d'attributs ressemble à celle ci-dessous (avec T 

(C) indiqué comme colonne sur laquelle le calcul sera effectué). Cliquez sur Update All 

(Mettre à jour). 

 
34. Vérifiez maintenant le résultat dans la table d'attributs. 

35. Cliquez à nouveau sur  pour basculer vers le mode non-édition. Cliquez sur 

Enregistrer pour enregistrer les modifications et fermer la table d’attributs. Si vous faites une 
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erreur, choisissez Rejeter pour annuler toutes les modifications depuis la dernière 

sauvegarde. 

36. Maintenant, retirez le tableau KNMI_temperatures_table et vérifier la table 

d’attributs de KNMI_stations. Quelles colonnes voyez-vous maintenant? Que pouvez-

vous conclure au sujet de la fonction rejoindre? Vous auriez aussi pu sauvegarder 

l'ensemble de la table d'attributs en sauvant KNMI_stations à un nouveau Shapefile en 

utilisant la fonction Enregistrer sous. 

5.4 Interpoler points à raster 

37. La dernière étape consiste à interpoler les valeurs de température à un Raster. Dans le 

menu, sélectionnez 

Raster > Analyse > Grille (interpolation) 

Si vous ne voyez pas ça, votre GdalTools plugin n’est pas activé. Vous pouvez l'activer dans 

le menu Plugins. 

 
38. Dans le dialogue spécifier le fichier de sortie: tday_NN.tif en utilisant la fenêtre de 

navigation et en spécifiant le format .tif. 

 

Cochez la case du champ Z et sélectionnez T(C). Ceci est le domaine que nous allons 

interpoler. 

Cochez la case Algorithme et sélectionnez Voisin le plus proche. Ceci est la fonction 

d'interpolation qui crée des polygones de Thiessen. 

Cochez Load into canvas when finished. 

Pour le reste du dialogue, gardez les valeurs par défaut. Le dialogue devrait ressembler à 

ceci: 
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Notez que le dialogue génère une commande de GDAL qui est donnée dans le champ 

d'édition. 

Cliquez sur OK pour continuer. 

Cliquez sur 2 x OK pour fermer les fenêtres pop-up, puis cliquez sur Fermer pour fermer la 

fenêtre de dialogue 

39. La carte de température interpolée est maintenant chargée dans l'affichage. Elle est 

visualisé en niveaux de gris, vous devez donc définir les options de visualisation. Faîtes un 

clic droit sur la carte et sélectionnez Propriétés. 

40. Sous l'onglet Style, jouer avec les différentes options et cliquez sur OK pour revenir à 

l'écran. 

41. Maintenant, faites glisser le fichier knmi_stations vers le haut afin d'afficher les 

stations au-dessus de la grille de température. 

42. Cliquez à droite sur la couche de knmi_stations et sélectionnez Propriétés. 

43. Sélectionnez l'icône Etiquettes et vérifiez l'étiquette de cette couche. Choisissez T (C) 
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comme champ pour l'étiquette. Jouez avec les options de placement (voir capture d'écran ci-

dessous) pour faire une belle carte. Cliquez sur Appliquer pour tester et OK pour visualiser. 

 
44. Maintenant, répétez l'interpolation en utilisant l’algorithme de distance inverse à une 

puissance (IDW) (répétition de l'étape 37). Appelez le fichier résultat tday_IDW.tif. 

Visualisez le résultat. Quelle méthode d'interpolation est la meilleure? Pourquoi? Pouvez-

vous expliquer le gradient de température sur la carte?  
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45. Vous pouvez enregistrer votre projet QGIS à ce point en choisissant à partir du menu 

Projet > Enregistrer sous.... Vous pouvez maintenant fermer QGIS et avez la possibilité de 

rouvrir ce projet la prochaine fois que vous utilisez QGIS. 

46. Nous pouvons également superposer nos données SIG nouvellement créées sur une 

carte topographique. A cet effet, vous devez installer le plugin QuickMapServices. Dans le 

menu aller à Plugins > Gérer et installer des plugins... et installer le plugin 

QuickMapServices si il n'a pas encore été installé. 

47. Choisissez dans le menu Web > QuickMapServices > OSM > OSM Mapnik. Assurez-

vous que votre couche vecteur de point est sur le dessus. 

 

 
 

 

 

 

 

 

 

 

 

Tout cet exercice peut être consulté dans un 

screencast à l’adresse: https://youtu.be/LKNga7cedt8 

https://youtu.be/LKNga7cedt8

